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Introduction to the 2-Generation Reproduction Toxicity Study Template
April 2005
GENERAL INSTRUCTIONS
You can navigate the template either by pressing the "arrow" keys or by using the mouse.  The sections will expand as you type.  When you begin filling out a template, save it with a filename different from that of the template itself, so that you will be able to keep the blank template in your original file for future use.  As a general rule, the text (excluding that of tables) should be in font size 9, style Bookman Old Style.  Text within tables and corresponding footnotes should be in font size 8, style Bookman Old Style.

To move quickly down the template to a specific section, click on the "View" menu, then select "Document Map."  When you click on a specific section name in the left-hand window, that section of the template will appear on the main screen.  To close the left-hand screen and work within the template, select "View," "Document Map" again. 

In the event that the study contains additional types of endpoints as part of the experiment, you can add sections (with appropriate re-numbering) as needed.  This template will also accommodate tables prepared in Microsoft Excel and Microsoft Access.

Many of the yellow highlighted areas in headings contain comments in a pop-up balloon or as hidden text.  These are suggestions or instructions relevant to that particular section.  They may be viewed either by moving your mouse over the yellow highlighted areas or clicking on the "View" menu, then "View Comments" or "Markup."  To prevent the comments from appearing in the printed document, cancel the "Markup" command or select "Document" under "Print what" when you issue the "Print" command. 

The comment sections may work best with Windows XP and related versions from which the template was created.
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Two-Generation Reproduction Toxicity Study 

Date of Submission:  


Title of Petition or Notification: 


Name and Address of Petitioner or Notifier: 


I. Identification of Study

A. Study File Location : 

B. Study Title/Report Number: 

C. Study Author:

D. Name and Address of Testing Facility: 

E. Study Initiation Date
: 

F. Study Completion Date
:
G. Study Objective:  

H. Comments: 

II. Good Laboratory Practice

A. Good Laboratory Practice (GLP) Compliance Statement?
 

B. Quality Assurance (QA) Statement?
 

C. Availability and Location of Original Data/Specimens/Test Substance: 

D. Describe any changes to the protocol that would affect the quality or integrity of the study:

E. Comments:

III. Executive Summary
IV. Materials and Methods
A. TEST SUBSTANCE

1. CAS name: 


2. Other name(s):


3. CAS number: 


4. Molecular structure: http://www.chemfinder.com/
 
5. Purity:



6. Impurities: 


7. Stability: 


8.
Comments:


B. TEST SUBSTANCE AS ADMINISTERED

1. Batch/lot number: 


2. Route: 


3. Vehicle used: 


4. Tested adequately for concentration? 

5. Tested for homogeneity? 


6. Tested for stability? 


7. Problems with storage? 


C. ANIMAL DIET

1.
Feed

a. Type:  



b. Name:



c. Availability: 


d. Analysis for contaminants: 

e. Comments: 


2.
Water

a. Source: 


b. Availability: 


c. Analysis for contaminants: 


d. Comments: 


D. TEST ANIMALS

1. Species/strain/substrain: 

2. Sex: 

3. Age range at initiation of study: 


4. Age range at mating:

5. Weight range at initiation of study: 


6. Weight range at mating:

7. Quarantine/acclimation? 


8. Physical examination times: 


9. Number per cage:  


10. Environmental conditions: 

· Temperature:

· Humidity:

· Air changes:

· Photoperiod:

· Bedding:

11. Comments: 

E. EXPERIMENTAL DESIGN

1. Targeted dose levels: 


2. Dose Selection Rationale:

3. Dosage Preparation:

Table # [Heading]

	test group
	conc. in diet

(ppm or mg/kg)
	dose to animals*

(mg/kg body-weight/day)
	number assigned per group

	
	
	f0 males
	f0 females
	f0 males
	f0 females

	Control
	
	
	
	
	

	Low
	
	
	
	
	

	Mid
	
	
	
	
	

	High
	
	
	
	
	


*Premating dose

Table # [Heading]

	test group
	conc. in diet

(ppm or mg/kg)
	dose to animals*

(mg/kg body-weight/day)
	number assigned per group

	
	
	f1 males
	f1 females
	f1 males
	f1 females

	Control
	
	
	
	
	

	Low
	
	
	
	
	

	Mid
	
	
	
	
	

	High
	
	
	
	
	


*Premating dose

4. Total number of parental animals: 


5. Duration of study (including recovery period, if any): 


6. Length of exposure to test substance:
 

7. Were animals assigned to test and control groups in a stratified random manner to minimize intergroup weight differences? 


8. Comments:  


F. MATING PROCEDURES

1. Description:

2. Comments:
G. CULLING PROCEDURES

1. Description:

2. Comments:

H. PARENTAL BODY WEIGHT AND FEED/WATER INTAKE

1. Parameters examined (in F0 and F1 animals): 
Table # [Heading]

	examined
	parameters*

	f0 parents
	f1 parents
	

	
	
	Body Weight

	
	
	Body Weight Changes

	
	
	Feed Intake

	
	
	Feed Spillage

	
	
	Water Intake


*These parameters are recommended in REDBOOK for 2-generation reproduction toxicity studies.

2. Comments: (e.g., list frequency) 
I. PARENTAL CAGE-SIDE OBSERVATIONS

1. Parameters examined (in F0 and F1 animals):  

Table # [Heading]

	examined
	parameters*

	f0 parents
	f1 parents
	

	
	
	Appearance

	
	
	Abnormal Stool

	
	
	Deficiencies in Care**

	
	
	Morbidity

	
	
	Mortality

	
	
	Neurotoxicity Screening (specify parameters)***


*These parameters are recommended in REDBOOK for 2-generation reproduction toxicity studies.

**Deficiencies in care include the following: inadequate construction or cleaning of the nest, pups left scattered and cold, physical abuse of pups, or inadequate lactation or feeding.

***The parameters for neurotoxicity screening may include, but are not limited to, the following: 

Changes in skin, fur, eyes, mucous membranes, gait, posture, and response to handling

Occurrence of secretions/excretions or other evidence of autonomic activity such as lacrimation, piloerection, pupil size change, unusual respiratory pattern

Presence of clonic or tonic seizure

Stereotype behaviors such as excessive grooming and repetitive circling

Bizarre behavior such as self-mutilating and walking backwards

Gross tumor development

2. Comments:
J. PARENTAL REPRODUCTIVE PARAMETERS

1. Reproductive parameters examined (in F0 and F1 animals):

Table # [Heading]

	examined
	parameters*

	f0 parents
	f1 parents
	

	
	
	Estrous Cycling

	
	
	Female Fertility Index

	
	
	Gestation Index

	
	
	Gestation Length

	
	
	Live-born Index

	
	
	Number of Primordial Follicles 

	
	
	Number of Growing Follicles

	
	
	Number of Large Corpora Lutea of Lactation from the Post-Lactation Ovary

	
	
	Number (Total and Per Liter) of Stillbirths at Day 0

	
	
	Number (Total and Per Liter) of Live Births at Day 0

	
	
	Number of Implantation Sites

	
	
	Number of Resorptions (Total, Early, and Late)

	
	
	Sperm Count 

	
	
	Sperm Motility

	
	
	Sperm Morphology


* These parameters are recommended in REDBOOK for 2-generation reproduction toxicity studies.

2. Indices Formulas:

3. Methods used for Sperm Analysis:

4. Comments:

K. PARENTAL ORGAN WEIGHTS

1. Organs/Tissues weighed (in F0 and F1 animals): 

Table # [Heading]

	examined
	parameters*

	f0 parents
	f1 parents
	

	
	
	Adrenals

	
	
	Brain

	
	
	Epididymides (single and total weight)

	
	
	Kidneys

	
	
	Known Target Organs

	
	
	Liver

	
	
	Ovaries

	
	
	Pituitary Gland

	
	
	Prostate (ventral and/or dorsal and/or dorsolateral)

	
	
	Seminal Vesicles (with coagulating glands)

	
	
	Spleen

	
	
	Testes (both)

	
	
	Thymus

	
	
	Uterus


* These parameters are recommended in REDBOOK for 2-generation reproduction toxicity studies.

2. Comments:  

L. PARENTAL GROSS PATHOLOGY OBSERVATIONS
f0 animals
1. Organs/Tissues Examined: 

2. Comments:   

f1 animals
1. Organs/Tissues Examined:
2. Comments:
M. PARENTAL HISTOPATHOLOGY OBSERVATIONS

1. Organs/Tissues were collected from which dose groups?  

2. Organs/Tissues were examined from which dose groups? 

3. How were the organs/tissues prepared for histopathology observation?  

4. Organs/Tissues collected (in F0 and F1 animals): 

Table # [Heading]

	system
	examined in 

f0 parents*
	not examined in 

f0 parents*
	examined in

f1 parents*
	not examined in

f1 parents*

	digestive
	
	Liver, Stomach


	
	Liver, Stomach



	reticulo- endothelial/

hematopoietic


	
	Bone Marrow, Lymph Nodes, Peyer’s Patch, Spleen, Thymus 


	
	Bone Marrow, Lymph Nodes, Peyer’s Patch, Spleen, Thymus 



	urogenital


	
	Epididymis, Kidneys, Ovaries, Primordial Follicles, Growing Follicles, and Large Corpora Lutea of Lactation from the Post-Lactation Ovary, Prostate, Seminal Vesicle with Coagulating Gland (if present), Testes, Uterus (with oviducts), Vagina


	
	Epididymis, Kidneys, Ovaries, Primordial Follicles, Growing Follicles, and Large Corpora Lutea of Lactation from the Post-Lactation Ovary, Prostate, Seminal Vesicle with Coagulating Gland (if present), Testes, Uterus (with oviducts), Vagina



	neurologic
	
	Brain (at least 3 different levels), Peripheral Nerve Tissue, Spinal Cord (at least 2 different locations)


	
	Brain (at least 3 different levels), Peripheral Nerve Tissue, Spinal Cord (at least 2 different locations)



	glandular
	
	Adrenals, Pituitary Gland, Thymus


	
	Adrenals, Pituitary Gland, Thymus



	other
	
	Target Organs 
	
	Target Organs 


* These parameters are recommended in REDBOOK for 2-generation reproduction toxicity studies.

5. Comments: 

N. OTHER PARENTAL TESTS

1. Observations: 

2. Comments: 

O. OFFSPRING OBSERVATIONS/BODY WEIGHT

1. Parameters examined (in F1 and F2 offspring):

Table # [Heading]
	observations
	examined in 

f1 offspring*
	not examined in 

f1 offspring*
	examined in

f2 offspring*
	not examined in

f2 offspring*

	cage-side
	
	Appearance

Gross Anomalies

Morbidity

Mortality
	
	Appearance

Gross Anomalies

Morbidity

Mortality

	other
	
	Litter Size (Total; Day 0, 4, 7, 14, 21)

Litter Weight (Day 0, 4, 7, 14, 21)

Pup Body Weight and Sex (Day 0, 4, 7, 14, 21)

Sex Ratio (Day 0, 4, 7, 14, 21)

Viability Index (Day 0-4, 4-7, 7-14, 14-21)

Weaning Index
	
	Litter Size (Total; Day 0, 4, 7, 14, 21)

Litter Weight (Day 0, 4, 7, 14, 21)

Pup Body Weight and Sex (Day 0, 4, 7, 14, 21)

Sex Ratio (Day 0, 4, 7, 14, 21)

Viability Index (Day 0-4, 4-7, 7-14, 14-21)

Weaning Index


*These parameters are recommended in REDBOOK for 2-generation reproduction toxicity studies.  

2. Offspring Indices:

3. Sexual Maturation (in F1 offspring only):

4. Anogenital Distance (in F2 offspring only)
:

5. Comments: (e.g., list frequency)
P. OFFSPRING DEVELOPMENTAL ENDPOINTS AND NEUROTOXICITY SCREENING - OPTIONAL

1. Parameters examined (in F1 and F2 offspring):

Table # [Heading]

	observations
	examined in 

f1 offspring
	not examined in 

f1 offspring
	examined in

f2 offspring
	not examined in

f2 offspring

	developmental endpoints
	
	Detachment of Pinna

Eye Opening

Tooth Eruption
	
	Detachment of Pinna

Eye Opening

Tooth Eruption

	gross neurotoxicity screening 
	
	Pupil Reflex

Startle Reflex

Surface and/or Mid-air Reflex

Vibrissae Placing
	
	Pupil Reflex

Startle Reflex

Surface and/or Mid-air Reflex

Vibrissae Placing


2. Comments: (e.g., list frequency)
Q. OFFSPRING IMMUNOTOXICITY - OPTIONAL

1. Parameters examined:  

Table # [Heading]

	measurement 

related to
	examined in 

f1 offspring
	not examined in 

f1 offspring
	examined in

f2 offspring
	not examined in

f2 offspring

	white blood cells


	
	Basophils

Eosinophils

Lymphocytes

Macrophage/

Monocytes

Neutrophils

Total Leukocytes (WBC)
	
	Basophils

Eosinophils

Lymphocytes

Macrophage/

Monocytes

Neutrophils

Total Leukocytes (WBC)

	organs/tissues

(weight changes)
	
	Lymph Nodes

Peyer’s Patch

Spleen

Thymus
	
	Lymph Nodes

Peyer’s Patch

Spleen

Thymus

	others


	
	Acute Phase Protein

Albumin

Albumin-to-Globulin Ratio

Bone marrow cytology

Electrophoretic Analysis of Serum Proteins

Globulin

Immunoglobulin G

Immunostaining of Spleen and Lymph Nodes for B and T Cells

Total Serum Protein
	
	Acute Phase Protein

Albumin

Albumin-to-Globulin Ratio

Bone marrow cytology

Electrophoretic Analysis of Serum Proteins

Globulin

Immunoglobulin G

Immunostaining of Spleen and Lymph Nodes for B and T Cells

Total Serum Protein


2. Fasting duration prior to blood collection: 
 
3. When in the study were the blood samples collected? 

4. How were the blood samples drawn? 

5. Comments:  


R. OFFSPRING ORGAN WEIGHTS
 

1. Organs/Tissues weighed: 

Table # [Heading]

	examined
	parameters*

	f1 offspring
	f2 offspring
	

	
	
	Brain

	
	
	Spleen

	
	
	Thymus


*These parameters are recommended in REDBOOK for 2-generation reproduction toxicity studies.

2. Comments:  

S. OFFSPRING GROSS PATHOLOGY OBSERVATIONS
f1 offspring
1. Organs/Tissues Examined: 

2. Comments:   

f2 offspring
1. Organs/Tissues Examined: 

2. Comments:   

T. OFFSPRING HISTOPATHOLOGY OBSERVATIONS

f1 offspring
1. Organs/Tissues were collected from which dose groups?  

2. Organs/Tissues were examined from which dose groups? 

3. How were the organs/tissues prepared for histopathology observation?  

4. Organs/Tissues collected: 

5. Comments:
f2 offspring
1. Organs/Tissues were collected from which dose groups?  

2. Organs/Tissues were examined from which dose groups? 

3. How were the organs/tissues prepared for histopathology observation?  

4. Organs/Tissues collected: 

5. Comments:
U. OTHER OFFSPRING TESTS

1. Observations: 

2. Comments: 

V. STATISTICAL METHODS
1. Methods of statistical analysis: 

Table # [Heading]

	methods of statistical analysis
	parameters tested

	
	

	
	

	
	

	
	


2. Comments: 

V. Results
W. DOSE VERIFICATION

1. Were doses verified? 


Table # [Heading]

	dose group
	targeted concentration 

 (ppm or mg/kg) 
	concentrations found in feed

(ppm or mg/kg)
	standarddeviation
	N*



	low
	
	
	
	

	mid
	
	
	
	

	high
	
	
	
	


* Number of measurements (N)

2. Verified by:    


3. Comments: 


X. PARENTAL FEED/WATER CONSUMPTION CHANGES

f0 parents
1. Observations during Premating and Postmating (males):
2. Observations during Premating (female): 
3. Observations during Gestation (female):

4. Observations during Lactation (female):

5. Comments: 

f1 parents
1. Observations during Premating and Postmating (males): 

2. Observations during Premating (female):

3. Observations during Gestation (female):

4. Observations during Lactation (female):

5. Comments: 

PARENTAL INTAKE OF TEST MATERIAL

1. Observations: 

Table # [Heading]

	dose group
	f0 males 

daily dose 

(mg/kg body-weight/day)
	f0 females 

daily dose 

(mg/kg body-weight/day)
	f1 males 

daily dose 

(mg/kg body-weight/day)
	f1 females 

daily dose 

(mg/kg body-weight/day)

	control
	0
	0
	0
	0

	low
	
	
	
	

	mid
	
	
	
	

	high
	
	
	
	


2. Comments: 

Y. PARENTAL FEED EFFICIENCY

f0 parents
1. Was feed efficiency calculated? 

2. Comments:  

f1 parents
1. Was feed efficiency calculated? 

2. Comments:  

Z. PARENTAL BODY WEIGHT CHANGES

f0 parents
1. Observations during Premating and Postmating (males): 

2. Observations during Premating (female):

3. Observations during Gestation (female):

4. Observations during Lactation (female):

5. Comments: 

f1 parents
1. Observations during Premating and Postmating (males):
2. Observations during Premating (female): 
3. Observations during Gestation (female):

4. Observations during Lactation (female):

5. Comments: 

AA. PARENTAL ABNORMAL CAGE-SIDE OBSERVATIONS

f0 parents
1. Observations: 


2. Comments: 


f1 parents

1. Observations:
2. Comments:
AB. PARENTAL MORTALITY

f0 parents
1. Observations: 


2. Comments: 


f1 parents

1. Observations:
2. Comments:
AC. MATING, FERTILITY, AND REPRODUCTION
1. Observations: 


Table # [Heading]

	GENERATION
	
	F0
	F1

	DAILY DOSE

(mg/kg body-weight/day)
	
	0

CONTROL
	
	
	
	0

CONTROL
	
	
	

	pregnancy
	
	
	
	
	
	
	
	
	

	Number of Females Paired
	
	
	
	
	
	
	
	
	

	Number of Females Achieving Pregnancy
	
	
	
	
	
	
	
	
	

	Female Fertility Index
	%
	
	
	
	
	
	
	
	

	Maternal Wastage
	
	
	
	
	
	
	
	
	

	# Died
	N
	
	
	
	
	
	
	
	

	# Died Pregnant 
	N
	
	
	
	
	
	
	
	

	# Died Nonpregnant
	N
	
	
	
	
	
	
	
	

	# Aborted
	N
	
	
	
	
	
	
	
	

	# Premature Delivery
	N
	
	
	
	
	
	
	
	

	Gestation
	
	
	
	
	
	
	
	
	

	Gestation Length
	MEAN

S.D.
	
	
	
	
	
	
	
	

	Gestation Index
	%
	
	
	
	
	
	
	
	

	corpora lutea
	
	
	
	
	
	
	
	
	

	Total # Corpora Lutea
	N
	
	
	
	
	
	
	
	

	Corpora Lutea/Dam
	MEAN

S.D.
	
	
	
	
	
	
	
	

	implantations
	
	
	
	
	
	
	
	
	

	Total # Implantations
	N
	
	
	
	
	
	
	
	

	Implantations/Dam
	MEAN

S.D.
	
	
	
	
	
	
	
	

	Resorptions
	
	
	
	
	
	
	
	
	

	Total # Resorptions
	N
	
	
	
	
	
	
	
	

	Resorptions/Dam


	MEAN

S.D.
	
	
	
	
	
	
	
	

	Total # Early Resorptions
	N
	
	
	
	
	
	
	
	

	Early Resorptions/Dam
	MEAN

S.D.
	
	
	
	
	
	
	
	

	Total # Late Resorptions
	N
	
	
	
	
	
	
	
	

	Late Resorptions/Dam
	MEAN

S.D.
	
	
	
	
	
	
	
	

	births – day 0
	
	
	
	
	
	
	
	
	

	Number Stillborns – Total

Per Liter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	Number Live-born  – Total

Per Liter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	Live-born Index
	%
	
	
	
	
	
	
	
	


(Specify methods of statistical analysis): * p<0.05, ** p<0.01

2. Sperm Evaluation:
Table # [Heading]

	GENERATION
	
	F0
	F1

	DAILY DOSE

(mg/kg body-weight/day)
	
	0

CONTROL
	
	
	
	0

CONTROL
	
	
	

	% Motile Sperm
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	% Progressively Motile Sperm
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	% Abnormal Sperm
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	# Homogenization Resistant Spermatids per Testis
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	# Homogenization Resistant Spermatids per mg Testis
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	# Sperm per Cauda
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	# Sperm per mg Cauda
	N
MEAN

S.D.
	
	
	
	
	
	
	
	


(Specify methods of statistical analysis): * p<0.05, ** p<0.01

2. Estrous Cycling Evaluation:
3. Comments: 


AD. PARENTAL ORGAN WEIGHTS

1. Observations: 


Table # [Heading]

	SEX
	f0 males 
	f0 females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	BODY WEIGHT (gram)a
	
	
	
	
	
	
	
	

	BRAIN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	ADRENALS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	EPIDIDYMIDESb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	KIDNEYS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	LIVER
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	PITUITARY GLAND
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	PROSTATEb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	SEMINAL VESICLES WITH COAGULATING GLANDb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	SPLEEN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	TESTESb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	THYMUS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	OVARIESb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	UTERUSb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	


a: Group means at the end of terminal necropsy are shown. 

b:
 Sexual organ weights should be recorded regardless of significant findings. 

(Specify methods of statistical analysis): * p<0.05, ** p<0.01

Table # [Heading]

	SEX
	f1 males 
	f1 females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	BODY WEIGHT (gram)a
	
	
	
	
	
	
	
	

	BRAIN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	ADRENALS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	EPIDIDYMIDESb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	KIDNEYS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	LIVER
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	PITUITARY GLAND
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	PROSTATEb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	SEMINAL VESICLES WITH COAGULATING GLANDb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	SPLEEN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	TESTESb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	THYMUS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	OVARIESb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	UTERUSb
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	


a: Group means at the end of terminal necropsy are shown. 

b:
 Sexual organ weights should be recorded regardless of significant findings. 

(Specify methods of statistical analysis): * p<0.05, ** p<0.01

1. Comments:
AE. PARENTAL GROSS PATHOLOGY CHANGES OBSERVED

f0 parents
1. Observations: 


2. Comments: 


f1 parents

1. Observations:
2. Comments:
AF. PARENTAL HISTOPATHOLOGY CHANGES OBSERVED

1. Observations: 


Table # [Heading] 
	SEX
	F0 MALES 
	F0 FEMALES 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	number of animals 
	
	
	
	
	
	
	
	

	digestive system
	
	
	
	
	
	
	
	

	name of organ/tissue# 
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	reticuloendothelial/

hematopoietic system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	urogenital system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	neurologic system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	glandular system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	other
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	


(Specify methods of statistical analysis): * p<0.05, ** p<0.01

# Organs/tissues listed under section IV.M.

In general, data at end of dosing period can be shown; however, if there were additional noteworthy findings at earlier time points, these should be included.  Note severity of lesions as needed.

Table # [Heading]

	SEX
	F1 MALES 
	F1 FEMALES 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	number of animals 
	
	
	
	
	
	
	
	

	digestive system
	
	
	
	
	
	
	
	

	name of organ/tissue# 
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	reticuloendothelial/

hematopoietic system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	urogenital system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	neurologic system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	glandular system
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	other
	
	
	
	
	
	
	
	

	name of organ/tissue#
	
	
	
	
	
	
	
	

	gross pathology
	
	
	
	
	
	
	
	

	histopathology-number of animals w/

non-neoplastic

lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	number of animals w/

neoplastic lesions
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	

	lesion
	
	
	
	
	
	
	
	


(Specify methods of statistical analysis): * p<0.05, ** p<0.01

# Organs/tissues listed under section IV.M.

In general, data at end of dosing period can be shown; however, if there were additional noteworthy findings at earlier time points, these should be included.  Note severity of lesions as needed.  

2. Comments: 

AG. OTHER PARENTAL TESTS

1. Observations: 

2. Comments: 

AH. OFFSPRING BODY WEIGHT CHANGES

1. Observations: 


Table # [Heading]

	GENERATION
	
	F1 MALES
	F1 FEMALES

	DAILY DOSE

(mg/kg body-weight/day)
	
	0

CONTROL
	
	
	
	0

CONTROL
	
	
	

	pup weight (g)
	
	
	
	
	
	
	
	
	

	Day 0
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 4
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 7
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 14
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 21
	mean

S.D.

N
	
	
	
	
	
	
	
	


(Specify a method of statistical analysis): * p<0.05, ** p<0.01

Table # [Heading]
	GENERATION
	
	F2 MALES
	F2 FEMALES

	DAILY DOSE

(mg/kg body-weight/day)
	
	0

CONTROL
	
	
	
	0

CONTROL
	
	
	

	pup weight (g)
	
	
	
	
	
	
	
	
	

	Day 0
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 4
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 7
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 14
	mean

S.D.

N
	
	
	
	
	
	
	
	

	Day 21
	mean

S.D.

N
	
	
	
	
	
	
	
	


(Specify a method of statistical analysis): * p<0.05, ** p<0.01

2. Comments:
AI. OFFSPRING OBSERVATIONS

1. Observations:
Table # [Heading]

	GENERATION
	
	F1 LITTER
	F2 LITTER

	DAILY DOSE

(mg/kg body-weight/day)
	
	0

CONTROL
	
	
	
	0

CONTROL
	
	
	

	litter size
	
	
	
	
	
	
	
	
	

	Number Born – Total

Per Litter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 0 – Total

Per Litter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 4 – Total

Per Litter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 7 – Total

Per Litter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 14 – Total

Per Litter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 21 – Total

Per Litter
	N

MEAN

S.D.
	
	
	
	
	
	
	
	

	litter weight (g)
	
	
	
	
	
	
	
	
	

	Day 0
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 4
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 7
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 14
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 21
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	viability Indices
	
	
	
	
	
	
	
	
	

	Day 0-4
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 4-7
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 7-14
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Day 14-21
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	weaning Index
	N
MEAN

S.D.
	
	
	
	
	
	
	
	

	Sex Ratio
	
	
	
	
	
	
	
	
	

	Day 1
	
	
	
	
	
	
	
	
	

	Day 21
	
	
	
	
	
	
	
	
	


(Specify a method of statistical analysis): * p<0.05, ** p<0.01

2. Comments:
AJ. OFFSRPING MORTALITY

f1 offspring
1. Observations: 


2. Comments: 


f2 offspring

1. Observations:
2. Comments:
AK. SEXUAL MATURATION
1. Observations (in F1 offspring only):

Table # [Heading]

	GENERATION
	
	F1 MALES
	F1 FEMALES

	DAILY DOSE

(mg/kg body-weight/day)
	
	0

CONTROL
	
	
	
	0

CONTROL
	
	
	

	Age of Preputial separation
	mean

S.D.

N
	
	
	
	
	

	Age of vaginal opening
	mean

S.D.

N
	
	
	
	
	


(Specify a method of statistical analysis): * p<0.05, ** p<0.01

2. Comments:

AL. ANOGENITAL DISTANCE

3. Observations (in F2 offspring only):

4. Comments:

AM. OFFSPRING DEVELOPMENTAL ENDPOINTS AND NEUROTOXICITY - OPTIONAL

f1 offspring
1. Developmental Endpoints:
· Detachment of Pinna:

· Eye Opening:

· Tooth Eruption:

2. Gross Neurotoxicity Observations:

· Pupil Reflex:

· Startle Reflex:

· Surface and/or Mid-air Reflex:

· Vibrissae Placing:

3. Comments: 

f2 offspring
1. Developmental Endpoints:
· Detachment of Pinna:

· Eye Opening:

· Tooth Eruption:

2. Gross Neurotoxicity Observations:

· Pupil Reflex:

· Startle Reflex:

· Surface and/or Mid-air Reflex:

· Vibrissae Placing:

3. Comments: 

AN. OFFSPRING IMMUNOTOXICITY - OPTIONAL

1. Observations: 

Table # [Heading]

	SEX
	f1 males 
	f1 females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	white blood cells
	
	
	
	
	
	
	
	

	Basophils 
	
	
	
	
	
	
	
	
	

	Eosinophils
	
	
	
	
	
	
	
	
	

	Lymphocytes
	109/L
	
	
	
	
	
	
	
	

	Macrophage/

Monocytes
	
	
	
	
	
	
	
	
	

	Neutrophils
	109/L
	
	
	
	
	
	
	
	

	Total Leukocytes (WBC)
	109/L
	
	
	
	
	
	
	
	

	others
	
	
	
	
	
	
	
	

	Acute phase proteins
	
	
	
	
	
	
	
	
	

	Total Serum Protein
	
	
	
	
	
	
	
	
	

	Albumin
	
	
	
	
	
	
	
	
	

	Albumin-to-Globulin Ratio
	
	
	
	
	
	
	
	
	

	Bone marrow cytology
	
	
	
	
	
	
	
	
	

	Globulin
	
	
	
	
	
	
	
	
	

	Immunoglobulin G
	
	
	
	
	
	
	
	
	


(Specify a method of statistical analysis): * p<0.05, ** p<0.01

Table # [Heading]

	SEX
	f2 males 
	f2 females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	white blood cells
	
	
	
	
	
	
	
	

	Basophils 
	
	
	
	
	
	
	
	
	

	Eosinophils
	
	
	
	
	
	
	
	
	

	Lymphocytes
	109/L
	
	
	
	
	
	
	
	

	Macrophage/

Monocytes
	
	
	
	
	
	
	
	
	

	Neutrophils
	109/L
	
	
	
	
	
	
	
	

	Total Leukocytes (WBC)
	109/L
	
	
	
	
	
	
	
	

	others
	
	
	
	
	
	
	
	

	Acute phase proteins
	
	
	
	
	
	
	
	
	

	Total Serum Protein
	
	
	
	
	
	
	
	
	

	Albumin
	
	
	
	
	
	
	
	
	

	Albumin-to-Globulin Ratio
	
	
	
	
	
	
	
	
	

	Bone marrow cytology
	
	
	
	
	
	
	
	
	

	Globulin
	
	
	
	
	
	
	
	
	

	Immunoglobulin G
	
	
	
	
	
	
	
	
	


(Specify a method of statistical analysis): * p<0.05, ** p<0.01

2. Noted Organ/Tissue Weight Changes:
· Lymph Nodes:

· Peyer’s Patches:

· Spleen:

· Thymus:

3. Electrophoretic Analysis of Serum Proteins:

4. Immunostaining of spleen and lymph nodes for B and T cells:

AO. OFFSPRING ORGAN WEIGHTS

1. Observations: 

Table # [Heading]

	SEX
	f1 males 
	f1 females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	BODY WEIGHT (gram)a
	
	
	
	
	
	
	
	

	BRAIN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	SPLEEN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	THYMUS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	


a: Group means at the end of terminal necropsy are shown. 

(Specify methods of statistical analysis): * p<0.05, ** p<0.01

Table # [Heading]

	SEX
	f2 males 
	f2 females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	BODY WEIGHT (gram)a
	
	
	
	
	
	
	
	

	BRAIN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	SPLEEN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	THYMUS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	


a: Group means at the end of terminal necropsy are shown. 

(Specify methods of statistical analysis): * p<0.05, ** p<0.01

2. Comments:

AP. OFFSPRING GROSS PATHOLOGY CHANGES OBSERVED

f1 offspring
1. Observations: 


2. Comments: 


f2 offspring

1. Observations:
2. Comments:
AQ. OFFSPRING HISTOPATHOLOGY CHANGES OBSERVED

f1 offspring
1. Observations: 


2. Comments: 


f2 offspring

1. Observations:
2. Comments:
AR. OTHER OFFSPRING TESTS

1. Observations: 

2. Comments: 

VI. Evaluation and Comment on Study

VII. Summary and Conclusions

AS. BRIEF SUMMARY OF MAJOR FINDINGS FROM THE STUDY
1. Parental Toxicity:

2. Offspring Toxicity:

AT. RELATIONSHIP BETWEEN DOSE AND INCIDENCE/SEVERITY OF LESIONS OR ABNORMALITIES
AU. NOEL
1. Was there a parental no observed effect level? 

2. Was there an offspring no observed effect level? 

3. Comments: 

VIII. References
�PAGE \# "'Page: '#'�'"  ��Please refer to the Introduction to the Template for general instructions before you begin using this form.


�PAGE \# "'Page: '#'�'"  ��Make note of: study file location (Volume, pages), study title/report #, testing facility name, publication dates of study, study objective, and comments, if needed. Indicate Yes or No for the rest of this section.  However, you may want to elaborate on the type of GLP compliance (USFDA, OECD, etc.) or make other notations.


�Date protocol was signed by study director.


�Date the final report was signed by the study director.


�FDA Good Laboratory Practice (GLP) regulations became effective June 20, 1979 and include the requirement for a Quality Assurance Statement. FDA also recognizes EPA and OECD GLP standards as being equivalent to those of FDA.


�Is a signed and dated Good Laboratory Practice Compliance Statement included in the study report? Answer Yes or No. If yes, provide the location of the statement in the study report and identify the GLP standard (FDA, EPA or OECD)


�PAGE \# "'Page: '#'�'"  ��Is a signed Quality Assurance Statement, including dates of inspections, provided in the study report? Answer Yes or No. If yes, provide the location of the statement in the study report.


�PAGE \# "'Page: '#'�'"  ��Description of the test substance should be given, including purity, any possible contaminants or impurities, and any properties of the test substance that might have affected its integrity. Are there factors that might have affected the actual administered dose, as opposed to the intended dose?


�PAGE \# "'Page: '#'�'"  ��After you put a blinking cursor on the http address, (CTRL +) left-click once to follow the link and wait.  Enter a chemical name, CAS Number, or molecular formula inside the search window and click ‘search’ button.  Right-click inside the molecular structure and select ‘copy’ submenu.  Return to your document and put the cursor underneath item #4 (molecular structure).  Right click to open up the menu options and select ‘paste’ submenu.  You can drag the structure to any position you want and resize.  If preferred, you are free to use other methods of depicting the molecular structure.


�PAGE \# "'Page: '#'�'"  ��Indicate how the test substance was given and whether any vehicle was used to dissolve/suspend the test substance (e.g., dissolved in corn oil and mixed into the feed).  Also note if there was adequate testing for concentration and homogeneity (appropriate tests with replicates) and whether there were stability tests done.  Was the strength of the test material checked over the period and under the conditions that the feed mix, test article in vehicle, etc., would be stored? 


�PAGE \# "'Page: '#'�'"  ��Note anything that might have affected the study. Use the comments to indicate extremes or other factors that might have impacted the study.


�PAGE \# "'Page: '#'�'"  ��Note anything that might have affected the study. Use the comments to indicate extremes or other factors that might have impacted the study.


�PAGE \# "'Page: '#'�'"  ��Provide adequate details so the information can be used to help prepare a toxicology evaluation report.  Use the comments to indicate additional information about the experimental design.  To change the table, place cursor in the row or column that you wish to modify, then from the ‘Table’ menu, use ‘Select Row’ or ‘Select Column’ to highlight the row or column that you wish to change, and use the ‘delete’ or ‘insert’ functions to make your changes.


�PAGE \# "'Page: '#'�'"  ��Describe how animals were mated.  Indicate when and how females were examined for pregnancy.  Note if sibling mating was avoided.


�PAGE \# "'Page: '#'�'"  ��Standardization of the number of pups per litter is optional.  If performed, describe how the litters were standardized (on what day, standardized to how many, if standardized in a random manner, etc.).


�PAGE \# "'Page: '#'�'"  ���PAGE \# "'Page: '#'�'"  ��Indicate the measurements or observations that were made by placing an ‘X’ in the ‘Examined’ side.  Those parameters not examined will not contain an ‘X’ in the ‘Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ��Indicate the measurements or observations that were made by placing an ‘X’ in the ‘Examined’ side.  Those parameters not examined will not contain an ‘X’ in the ‘Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ��Indicate the measurements or observations that were made by placing an ‘X’ in the ‘Examined’ side.  Those parameters not examined will not contain an ‘X’ in the ‘Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ���PAGE \# "'Page: '#'�'"  ��Indicate the measurements or observations that were made by placing an ‘X’ in the ‘Examined’ side.  Those parameters not examined will not contain an ‘X’ in the ‘Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ��To split a table (between 2 pages): Place the cursor in the table.  From the ‘Table’ menu, choose ‘Select Table’ to highlight.  From the ‘Format’ menu, select ‘Paragraph’ then the ‘Line and Page Breaks’ tab.  Uncheck the box ‘Keep with next’ to split the table.


�PAGE \# "'Page: '#'�'"  ��When other tests are conducted, make note of the tests and any significant treatment-related effects.


�PAGE \# "'Page: '#'�'"  ��Indicate the measurements or observations that were made by highlighting the parameter and dragging the term into the ‘Examined’ side.  Those parameters not examined will remain in the ‘Not Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ��For litter weight, pup body weight and sex, sex ratio, and viability index, please list the days examined in parentheses, especially if different from those listed in the table below.


�Anogenital distance should be measured at day zero for all F2 pups that show treatment-related effects in F1 sex ratio or sexual maturation.


�This section is optional.  Indicate the measurements or observations that were made by highlighting the parameter and dragging the term into the ‘Examined’ side.  Those parameters not examined will remain in the ‘Not Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ��This section is optional.  Indicate the measurements or observations that were made by highlighting the parameter and dragging the term into the ‘Examined’ side.  Those parameters not examined will remain in the ‘Not Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ��Indicate the measurements or observations that were made by placing an ‘X’ in the ‘Examined’ side.  Those parameters not examined will not contain an ‘X’ in the ‘Examined’ side. Use the comments to indicate when observations were made and any other notable fact.


�PAGE \# "'Page: '#'�'"  ��For F1 and F2 weanlings, histopathology examination of treatment-related abnormalities noted at macroscopic examination should be considered, if deemed appropriate and would contribute to the overall quality of the study data.


�PAGE \# "'Page: '#'�'"  ��When other tests are conducted, make note of the tests and any significant treatment-related effects.


�PAGE \# "'Page: '#'�'"  ��Note here whether there was a check or verification of the doses being administered (by what analytical methodology and in which laboratory). If the test substance was mixed in the feed, was the level of the test substance in the feed analyzed? Was this done more than once? Are there adequate data to permit the calculation of the actual dose that was administered?


�PAGE \# "'Page: '#'�'"  ��Note any statistically or biologically significant feed/water consumption changes. You may also want to note feed/water consumption changes that are not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.


�PAGE \# "'Page: '#'�'"  ��Knowing what the intake of feed/water was and the level of test substance in the feed/water, what was the dose actually being delivered to the animals?  This section would not be relevant for a gavage study.


�PAGE \# "'Page: '#'�'"  ��Note in this section if feed efficiency was determined; when in the study determinations were made; if any changes were observed; if feed efficiency was calculated for all groups or only selected groups; and if calculations were made per group, per cage, or per animal.


�PAGE \# "'Page: '#'�'"  ��Note any statistically or biologically significant body weight changes. You may also want to note body weight changes that are not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  You may wish to insert graphs or tables in this section.


�PAGE \# "'Page: '#'�'"  ��List significant, dose-related abnormal clinical observations reported.  This may include neurotoxicity endpoints.


�PAGE \# "'Page: '#'�'"  ��For each animal with an unscheduled death, note the group, date of death, and any observations, including lesions observed at necropsy.


�PAGE \# "'Page: '#'�'"  ��Note findings that are statistically or biologically treatment-related.  Also note the changes that are not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The comment section is available to explain data findings, if needed.


�PAGE \# "'Page: '#'�'"  ��Note findings that are statistically or biologically treatment-related.  The type of lesion should be noted. The comment section is available to explain data findings, if needed.


�PAGE \# "'Page: '#'�'"  ��Note findings that are statistically or biologically treatment-related. The type of lesion should be noted. The comment section is available to explain data findings, if needed.


�PAGE \# "'Page: '#'�'"  ��When other tests are conducted, make note of the tests and any significant treatment-related effects.


�PAGE \# "'Page: '#'�'"  ��Note findings that are statistically or biologically treatment-related. Also note the changes that are not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The comment section is available to explain data findings, if needed.  If the study measures pup weight on days that are different than those listed, please correct the information so it corresponds with the study.


�PAGE \# "'Page: '#'�'"  ��List significant, dose-related abnormal observations reported.  If the study measures litter size, litter weight, viability, or sex ratio on days that are different than those listed, please correct the information so it corresponds with the study.


�PAGE \# "'Page: '#'�'"  ��For each pup with an unscheduled death, note the group, date of death, and any observations, including lesions observed at necropsy.


�Anogenital distance should be measured at day zero for all F2 pups that show treatment-related effects in F1 sex ratio or sexual maturation.


�This section is optional.  �PAGE \# "'Page: '#'�'"  ��List significant, dose-related developmental or neurotoxicity changes observed.


�PAGE \# "'Page: '#'�'"  ��This section is optional.  List treatment-related findings in the immune system that were noted under result sections V.T: Offspring Organ Weights, V.U: Offspring Gross Pathological Changes, and V.V: Offspring Histopathological Changes.  Provide a statement about whether or not the test substance presents a potential hazard to immunology.


�PAGE \# "'Page: '#'�'"  ��Note findings that are statistically or biologically treatment-related.  Also note the changes that are not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The comment section is available to explain data findings, if needed.


�PAGE \# "'Page: '#'�'"  ��Note findings that are statistically or biologically treatment-related.  The type of lesion should be noted. The comment section is available to explain data findings, if needed.


�PAGE \# "'Page: '#'�'"  ��Note findings only if treatment-related abnormalities were noted at macroscopic examination and contributed to the overall quality of the study data.  The type of lesion should be noted. The comment section is available to explain data findings, if needed.


�PAGE \# "'Page: '#'�'"  ��When other tests are conducted, make note of the tests and any significant treatment-related effects.


�PAGE \# "'Page: '#'�'"  ��Give your impressions of the study: what was done well; what the problems were; did the study accomplish what it was supposed to do?  


�PAGE \# "'Page: '#'�'"  ��Summarize the key findings from the study. Was there a dose-effect relationship? Were target organs identified? Was a parental NOEL achieved for each significant effect/observation? What was the NOEL?  Was an offspring NOEL achieved for each significant effect/observation? What was the NOEL?  The whole study should be summarized in this section.
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